CHAPTER 15

Designing Pressure
Pipe Networks

Now that you have studied gravity pipe networks, it’s time to move on

to a different type of pipe design: one that involves pipes under pressure. If
you’re unfamiliar with pipe design, you may be surprised to discover that the
design process for gravity and pressure systems is quite different. For this
reason, the AutoCAD® Civil 3D® software provides two unique tool sets: one
for gravity pipe design and one for pressure pipe design.

Pressure pipe design most commonly refers to water supply lines but it can
also apply to natural gas and sanitary sewer lines. These pipelines provide
valuable utility services to the new residents of the land you're developing
and must undergo extensive design to ensure that they function as intended
and integrate well with surrounding features, whether new or existing.

In this chapter, you'll learn to:

Understand pressure pipe networks
Create pressure pipe networks

Edit pressure pipe networks

Understanding Pressure Pipe Networks

Gravity system designs and pressure system designs are quite different and
must be addressed using different tools. For a pressure pipe network design
to be a success, it must meet the following basic requirements:

» The bends and curves must be constructed according to industry-
standard fittings and allowable joint deflections.
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» The pipes must be sized according to specific flows and pressures.
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» The pipes must be far enough underground to avoid being damaged
by freezing or by activities on the site.

» The pipes must not be so far underground that it is cost prohibitive
to install them.

» Appurtenances such as valves and hydrants must be included in the
design to allow the lines to be controlled, accessed, and maintained.

These requirements relate to three basic types of pressure pipe design compo-
nents: fittings, pipes, and appurtenances. This chapter describes these compo-
nents as well as their relationship to each other when represented in a Civil 3D
pressure network.

Understanding Fittings, Angles, and
Appurtenances

Pressure pipe fittings serve two purposes. The first, like structures in gravity sys-
tems, is to enable two or more pipes to connect. For example, a tee or wye fitting
provides a connection for three pipes, and a crossing fitting provides a connection
for four. The second purpose of a fitting is to create a bend in the direction of the
pipeline, the angle of which is typically dictated by manufacturing standards. For
example, elbows are commonly available in 90°, 45°, 22.5°, and 11.25° versions. For
this reason, bend angles are a big part of pressure pipe design.

In addition to bend angles, a slight amount of deflection is allowed within
connections. This deflection angle is part of the design and varies depending on
how the pipes or fittings have been manufactured. This allowable deflection also
enables a series of pipes to form a curve by providing a little deflection at each
joint but without bending the pipes. Therefore, pressure pipes can be laid out on
a curve, with the radius determined by the allowable deflection.

Another factor that can be incorporated into the design is the allowable bend-
ing radius of the pipes. Bending the pipes is another way a system can be laid
out along a curve. The allowable bending radius is a function of the size, mate-
rial, and manufacturer specifications of the pipe.

Because of available fittings, allowable deflection angles, and allowable bend
radius, each bend in a pressure pipe is a design in itself. As a designer, you'll be
required to choose the right combination of fitting, deflection angle, and bend
radius to make each bend in the pipeline.

Appurtenances are another component of pressure pipe designs. The chal-
lenge with appurtenances is that they usually require consideration for human
access. For example, a fire hydrant must be properly located at ground level so
that firefighters or maintenance personnel can access it.
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Understanding Pressure Pipes

Like gravity pipes, pressure pipes are used to convey a substance, but the main
difference, of course, is that the substance is moved by pressure rather than
gravity. For this reason, elevations aren’t nearly as important to ensure adequate
flow. They are important, however, to ensure that the pipeline has adequate
cover to prevent freezing or physical damage and that it avoids underground
obstacles, including other pipes. In the event of a conflict, because pressure pipe
flow isn’t dependent on elevation, a designer will typically bend a pressure pipe
to avoid a gravity pipe rather than the other way around. As discussed previ-
ously, the required bends are a design challenge because of the limitations of
available fittings and deflection angles.

Exploring the Pressure Network

Civil 3D enables you to create objects that represent fittings, pipes, and appur-
tenances. It also establishes relationships between these components as well
as relationships with other important design elements such as surfaces, align-
ments, profiles, and profile views. The pipes, fittings, and appurtenances and
their associated relationships are referred to as a Civil 3D pressure network. In
Figure 15.1, a few pipes and fittings are shown in plan view on the left, profile
view in the center, and 3D view on the right.

FIGURE 15.1 Apressurenetwork shown in plan view (left), profile view (center), and
3D view (right)

Each component of a pressure network is shown in Prospector beneath the
Pressure Networks node. From here, you can right-click each component to
access various context commands for it. You can also use the item view at the
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bottom of Prospector to edit information about each component. Figure 15.2
shows the contents of a pressure network in Prospector.
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FIGURE 15.2 Apressurenetwork shown in Prospector

Just as in gravity networks, the shape, dimensions, and behavior of a pres-
sure network component are determined by the part that represents it. Pressure
networks have their own parts lists, separate from gravity networks. Most com-
panies have several parts lists, each one containing parts for a certain type of
system such as water, sanitary, or natural gas.

Creating Pressure Pipe Networks

As with gravity networks, pressure networks can be created in one of two ways.
The first is to lay out the pressure network using basic AutoCAD® entities such
as lines or polylines and then convert those objects to a pressure network.
Another is to create the pressure network using layout tools. One difference
with pressure networks is that the layout tools are housed in the ribbon rather
than on a toolbar. The specialized ribbon tab (see Figure 15.3) is launched by
using the Pressure Network Creation Tools command.
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FIGURE 15.3 Thespecialized ribbon tab for pressure network layout

Creating a Pressure Network from Objects

At times, you'll find it easier to start with AutoCAD commands to sketch your

pressure network using basic entities. This approach works quite well because

Civil 3D provides a command that converts these basic entities to pressure net-

works: the Create Pressure Network From Object command. This command

creates pipe networks from Civil 3D alignments and feature lines as well. One :::T::ta(:r m:lzfeds for
disadvantage of this method is that the same parts are used for pipes and fit- Chapter 15 according to

tings throughout the entire network. the instructions in this
book’s Introduction.

If you haven't already

Exercise 15.1: Create a Pressure Network from <0 |
Objects
In this exercise, you’ll create a waterline pressure network along Madison Lane

K

by converting objects in the drawing. You'll also draw that pressure network in
profile view.

1. Open the drawing named Creating Pressure Networks from
Objects.dwg located in the Chapter 15 class data folder.

You may notice that the
2. In the left viewport, note the heavy blue polyline along Madison storm system has been
Lane labeled with W, indicating a schematic location for a proposed changed to redin the

example drawings for
this chapter. This is to

3. On the Home tab of the ribbon, click Pipe Network > Create m make it easier to differ-

Pressure Network From Object. entiate the storm pipes
from the water pipes

4. Click the heavy blue polyline, and press Enter to accept the default you'll be creating.
direction assumed by the command.

waterline.

5. In the Create Pressure Pipe Network From Object dialog box, do the
following:

a. For Network Name, enter Madison Lane Water.
b. For Network Parts List, select Water Supply.
c. For Size And Material, select 4 INCH (100mm) DUCTILE IRON.
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d. For Surface Name, select Road FG.
e. For Alignment Name, select Madison Lane.

f. For Depth Of Cover, verify that 3.000' (1.000m) is the value
currently applied.

g. Check the box next to Erase Existing Entity.
h. Click OK.

It may not appear that much has happened, but the polyline has
been converted to a 3D model of a waterline, complete with pipes and
bends. You can zoom in to the newly created waterline model in the
3D view to examine the result.

. Click the Modify tab of the ribbon. Then expand the Design panel,
and select Pressure Pipe Network.

=q
[

m 7. Click Draw Parts In Profile on the ribbon. Click one of the new water-
line parts, and press Enter to indicate that you would like to draw the
entire network.

8. Click one of the grid lines of the Madison Lane profile view in the top-
right viewport. The waterline parts are displayed in the profile view,
as shown in Figure 15.4.

N4

FIGURE 15.4 Pressurenetwork parts (indicated with red arrows) shown in
profile view along with other profile information
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9. Save and close the drawing.
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You can view the results of successfully completing this exercise by opening
Creating Pressure Networks from Objects - Complete.dwg.

PRESSURE NETWORKS FROM FEATURE LINES

You may have noticed the Use Vertex Elevations option in the Create Pressure Pipe
Network From Object dialog box. If you create a pressure network from a feature
line, you can use this option to set the elevations of the pipes and fittings based
on the elevations of the feature line. You can also choose the reference point
thatis used when assigning elevations such as Outside, Top, Crown, Centerline,
and so on. This is an effective way to convert a rough 3D sketch of a pressure
pipe design into a full-fledged 3D pressure network model.

Creating a Pressure Network by Layout

Another way to create pressure networks is using the Pressure Network Creation
Tools command. When you launch this command, you will see a specialized
ribbon tab (as shown previously in Figure 15.3) that contains tools for pressure
network layout. From this specialized ribbon tab, you can choose the pipes,
fittings, and appurtenances from the parts list and use the commands on the
ribbon to insert those parts into the drawing. You can change parts at any time
and apply different types and sizes as you go.

To guide your design, Civil 3D provides a compass (see Figure 15.5), which displays
the bend angles and deflections available at a given point, based on information
stored in the parts list. The compass automatically “snaps” your cursor to an available
bend angle to prevent you from laying out a nonstandard bend in the pipeline.

FIGURE 15.5 Thecompass (thered circle) shows the available bend angles and deflections.
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Cover refers to the dis-
tance from the top of
the pipe to the surface
of the ground.

If you haven't already
done so, download

and install the files for
Chapter 15 according to
the instructions in this
book’s Introduction.

In this drawing, red
circles have been pro-
vided to indicate the
locations of bends.

Notice the compass
that appears at point
B, which shows the
allowable deflection
at the pipe joint and
restricts the ability to
draw the next pipe, to
stay in that allowable
deflection.

A new 90° fitting
should be placed at the
end of the pipe, but it
curves in the wrong
direction.

Chapter 15 « Designing Pressure Pipe Networks

Another fundamental difference with pressure network layout is that you pro-
vide a value for cover, and Civil 3D automatically sets the elevation at each end
of a pipe according to that value. You can change the cover value as you design.

Exercise 15.2: Create a Pressure Network by
Layout

In this exercise, you’ll use layout tools to begin designing the waterline pressure
network along Jordan Court.

1. Open the drawing named Creating Pressure Networks by Layout
.dwg located in the Chapter 15 class data folder.

E 2. On the Home tab of the ribbon, click Pipe Network > Pressure
Network Creation Tools.

3. In the Create Pressure Pipe Network dialog box, do the following:
a. For Network Name, enter Water Main.
b. For Parts List, select Water Supply.
c. For Surface Name, select Road FG.
d. For Alignment Name, select Jordan Court.
e. Click OK.
4. The Pressure Network Plan Layout ribbon tab opens. Do the following:
a. In the Network Settings panel, enter 4.5 (1.5) for Cover.

b. Under Select A Size And Material, select 6 INCH (150mm)
DUCTILE IRON.

5. Click Pipes Only. Snap to the center of the circle marked A; then snap
to the center of the circle marked B.

6. At the command line, click Curve to apply the Curve option. Snap to
the center of the circle marked C.

7. At the command line, click Straight to apply the Straight option.
Snap to the center of the circle marked D.

m 8. On the ribbon, to the right of Add Fitting, select 6 INCH (150mm)
ELBOW 90 DEG. Click Add Fitting. Snap to the end of the last pipe
you drew.
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9. Press Esc to end the current command. In the lower-right viewport,
zoom in to the area where you inserted the fitting so you can observe

the development of the design in 3D.
10. In the left viewport, click the new fitting, and then click the

northward-pointing arrow grip to flip the fitting so it curves toward

the southwest. Press Esc to clear the selection of the fitting.

11. Click Pipes & Bends on the ribbon. In the left viewport,
click the 90° elbow, and then snap to the center of the circle
marked E.

12. On the command line, click Curve to apply the Curve option. Click a

Notice the difference
in the compass, which

now shows available
bend angles rather

point somewhere between circles E and F; then snap to the center of than deflections. The

circle F. Press Esc to end the command.

available angles are

A new 90° elbow has been inserted, and a curved section of pipe based on the fittings

has been drawn from circle E to circle F (see Figure 15.6).

listed in the parts list.

THEH Bometricl Shaded]

and the curved section of pipe between circles Eand F

13. Save and close the drawing.

Creating Pressure Networks by Layout - Complete.dwg.
Editing Pressure Pipe Networks

you can analyze your design from more than one perspective. This is done
using the Draw Parts In Profile View command, much as you did with grav-
ity networks. And just like gravity networks, pressure networks can be edite
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FIGURE 15.6 Thenewlydrawn waterline, including the 90° elbow at circle E

You can view the results of successfully completing this exercise by opening

Before editing a pressure network, it’s best to display it in profile view so that

d

using four basic approaches: grips, layout tools, properties, and Pipe Network
Vistas. Of these four approaches, the grips and layout tools approaches differ

Chappell, Eric. AutoCAD Civil 3D 2016 Essentials : Autodesk Official Press, John Wiley & Sons, Incorporated, 2015. ProQuest Ebook Central,
http://ebookcentral.proquest.com/lib/osu/detail.action?doclD=2052358.
Created from osu on 2017-07-18 11:25:06.



Copyright © 2015. John Wiley & Sons, Incorporated. All rights reserved.

306
\\
N S
\\
N g S
a
\\
\E,_;LZ(
a

|

Chapter 15 « Designing Pressure Pipe Networks

considerably from how they are applied in gravity systems. The sections entitled,
“Editing Pressure Networks Using Grips” and “Editing Pressure Networks Using
the Plan Layout Tools” explain the details of how these two approaches are
applied to pressure networks.

Editing Pressure Networks Using Grips

Grips are a great tool for making quick and simple graphical edits. Civil 3D pro-
vides the following specialized grips for pressure pipes and fittings:

Fitting — Square Grip - Plan View This grip changes the location of the fit-
ting without changing its rotation. As the fitting is moved, the ends of any pipes
that connect to it will move with it.

Fitting — Arrow Grip — Plan View This grip changes the direction of the fit-
ting by flipping it around the axis of the connecting pipe.

Fitting — Diamond Grip - Plan View This grip slides the fitting along the
pipe it’s connected to without changing the rotation angle of the fitting.

Fitting — Plus Grip - Plan View This grip creates a new pipe projecting from
the end of the fitting, with the angle restricted to the allowable deflection at the
joint. This grip doesn’t appear in a location where a pipe is already connected.

Fitting - Diamond Grip - Profile View This grip changes the elevation of
the fitting.

Pipe Endpoint — Square Grip - Plan View This grip changes the location
of one end of the pipe without changing the location of the other. It’s available
only if neither end of the pipe is connected to a fitting.

Pipe Endpoint - Diamond Grip - Plan View This grip swings the pipe
around a fitting at the opposite end. A graphic displays the allowable deflection
but doesn’t restrict movement to stay within it. This grip doesn’t change the
length of the pipe.
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Pipe Endpoint — Plus Grip — Plan View This grip creates a new fitting and
pipe projecting from the end of the pipe you've selected. The angle of the new pipe
is restricted to the allowable angles as per the fittings in the parts list. This grip
doesn’t appear in a location where a fitting is already connected.

Pipe Endpoint — Triangular Grip - Plan View This grip changes the length
of the pipe while maintaining the angle of the pipe and the location of the oppo-
site end. If the pipe is curved, it maintains the radius of the pipe while extending
it along its own curvature.

Pipe Midpoint Grip — Plan View For a straight pipe, this grip changes the
location of the pipe without changing its rotation. It disconnects the pipe from
any fittings it’s attached to. For a curved pipe with a connection at both ends,
this grip changes the radius of the curve without changing the location of
either endpoint. If one or both of the ends aren’t connected, it works the same
as if it’s a straight pipe.

Pipe Endpoint Grips — Profile View These grips change the elevation of a
pipe at its endpoint. The diamond-shaped grip at the top sets the crown (top
of the inside wall) elevation. The diamond-shaped grip at the bottom sets the
invert (bottom of the inside wall) elevation. The triangular grip sets the cen-
terline elevation. These grips can be used in conjunction with the AutoCAD
Dynamic Input feature to view the elevation or even type it in. They don’t
change the horizontal location of the pipe’s endpoint.

Pipe Endpoint - Triangle Grip — Profile View This grip changes the length
of the pipe while holding its slope.

Pipe Midpoint — Square Grip - Profile View This grip changes the eleva-
tion of the pipe without changing its slope. It doesn’t affect the location of the
pipe in plan view. It disconnects the pipe from any fittings or appurtenances it’s
connected to.

Pipe Midpoint - Circular Grip - Profile View This grip curves the pipe by
holding the endpoints and forcing it to pass through the new location that you
select for the grip. Movement isn’t restricted based on allowable deflections.
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B Exercise 15.3: Edit a Pressure Network Using Grips

If you haven't already In this exercise, you'll make some adjustments to the layout of the waterline
done so, download pressure network along Jordan Court. You'll use some of the specialized grips to
andinstall the files for make these adjustments in plan and profile.

Chapter 15 according to

the instructions in this 1.

book’s Introduction.

The location of the next

fitting will be outside 3.

the area covered by
the Road FG surface,
and it will therefore
be based on EG surface
elevations.

Notice how the end of

the pipeisn't located
at the elevation of

where you snapped.
Civil 3D calculated the
elevation based on the
surface and the Cover
value you specified.
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the center of circle G, 6
even though that’s E :

Open the drawing named Editing Pressure Networks Using
Grips.dwg located in the Chapter 15 class data folder.

. In the left viewport, zoom in to the circle marked D1, and click the

90° elbow fitting near its center. Click the fitting, and then click the
square grip.

Snap to the center of the circle marked D2. The fitting moves to the new
location along with the ends of the two pipes that are connected to it.

The geometry of the fitting looks a bit odd at the moment because
the fitting should be changed to a 45° elbow. This will be addressed in
a later exercise.

In the lower-right viewport, click the curved pipe between E and F1; then
click the triangular grip at circle F1. Snap to the center of circle F2.

Click the plus-sign grip at circle F2. On the ribbon, select EG as
the surface, and change the Cover value to 4.5 (1.5). Select 6 INCH
(150mm) DUCTILE IRON as the pipe size, and snap to the center of
circle G.

Press Esc to end the current command and clear any selections in
the drawing. Click the pipe between E and F2, and then click Draw
Parts In Profile on the Pipe Networks: Water Main ribbon tab.

. Click one of the grid lines of the Jordan Court profile view.

The water pipe should appear in the profile view.

. Press Esc to clear the current selection. Select all pipes and fittings

from circle E to circle A; then use the Draw Parts In Profile command
to add them to the profile view.

The waterline should now appear in the profile view, as shown in
Figure 15.7.
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A s

FIGURE 15.7 Thewatermain pressure pipes and fittings shown in profile view

9. In the profile view, click the second fitting from the left, located near
station 2+75 (0+080). Click the diamond-shaped grip. If Dynamic
Input is turned off, turn it on by clicking the icon at the bottom of
your screen.

10. Zoom out until you can see the Dynamic Input elevation value for the

grip. Type 184 (55.45), and press Enter.
11. Pan to the right, and click the long pipe at the right end of the water

main. Click the circular grip; then click a point slightly above the pipe.

12. Save and close the drawing.

You can view the results of successfully completing this exercise by opening
Editing Pressure Networks Using Grips - Complete.dwg.

Checking Design and Depth

Before performing any edits on a pressure network, you may find it helpful to
use the Design Check and Depth Check commands to identify necessary edits.
Both these commands are found on the Pressure Networks ribbon tab. The
Design Check command checks for issues with deflection, mismatched pipe
diameters, open connections, and radius of curvature. Depth Check finds issues
with minimum and maximum cover.

Exercise 15.4: Check Design and Depth

In this exercise, you'll check the waterline along Jordan Court for deflection and
depth issues.

1. Open the drawing named Checking Design and Depth.dwg located
in the Chapter 15 class data folder.

2. Click the pipe that runs from circle D2 to circle E. Then click Design
Check on the ribbon.
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Chapter 15 according to
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The warning symbols
are visible only in plan
and profile view, not
3D view.

.

If you're having trouble
getting the tooltips to
appear, try zooming in
and then running the
REGEN command.
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3. In the Run Design Check dialog box, uncheck all boxes except
Deflection, and then click OK.
Two warning symbols appear, one at each end of the pipe.

4. Zoom in to one of the warning symbols, and hover your cursor over it.
The tooltip should indicate that deflection has been exceeded.

5. Press Esc to clear the current selection. Then, in the Jordan Court
profile view, select the long water pipe that extends under the hill.
Click Depth Check on the ribbon.

6. Select the same pipe again, and press Enter. In the Run Depth Check
dialog box, check the box next to Maximum Depth Of Cover. Enter
4.5 (1.5) for Minimum Depth Of Cover and 10 (3) for Maximum Depth
Of Cover. Click OK.

7. In the top-right viewport, notice the warning symbol that appears
on the pipe directly below the high point of the hill. Hover over the
warning symbol to reveal the tooltip, which states that maximum
depth of cover has been exceeded.

8. Save and close the drawing.

You can view the results of successfully completing this exercise by opening
Checking Design and Depth - Complete.dwg.

Editing Pressure Networks Using the Plan
Layout Tools

One way to edit a pressure network is to use the Pressure Network Plan Layout
ribbon tab, which is the same one you used initially to create the pressure
network. To launch the ribbon in editing mode instead of creation mode, you
select a component of the pressure network and then click Edit Network > Plan
Layout Tools (see Figure 15.8).

Autod 360 Help Add-ins Geote:

JE ' FE > @ E/ j:’i Iﬁ r—%

Network | Edit | PressurePipe_  Fitting _ Appurtenance Partslist DrawParts Desi th  Alignment
roperties  Network Properties Properties Properties = in Profile  Ch ck  from Network

Network Tools yz Launch Pad

Plan Lavout Tools
L3

iting a Pressure Ne..Pr
j+]ﬂ0p][20 Wireframe] ) M Profile Layout Tools |

FIGURE 15.8 Launchingthe Pressure Network Plan Layout ribbon tab by clicking the Plan
Layout Tools command
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Exercise 15.5: Use the Plan Layout Tools

In this exercise, you'll use the Plan Layout Tools to change out several fittings
and add a pipe to the end of the waterline network along Jordan Court.

1. Open the drawing named Editing a Pressure Network Using Plan
Layout Tools.dwg located in the Chapter 15 class data folder.

2. In the left viewport and the lower-right viewport, zoom in to circle
D2. Click the elbow located near the center of the red circle at D2,
and press the Delete key to delete it.

3. Click one of the pipes to display the Pressure Networks ribbon tab.
Then click Edit Network > Plan Layout Tools.

4. On the Pressure Network Plan Layout ribbon tab, do the following:
a. Verify that Road FG is the selected surface.
b. For Cover, enter 4.5 (1.5).
c. Select 6 INCH (150mm) DUCTILE IRON as the pipe size.
d. Select 6 INCH (150mm) ELBOW 45 DEG as the fitting.

5. Click Add Fitting; then, in the left viewport, click the end of either
pipe in the D2 circle. Press Esc twice to end the command and clear
the selection. If the fitting is turned the wrong way, click it and use
the arrow grip to flip it in the right direction.

6. Click the pipe that isn’t connected, to display its grips. Click the
diamond-shaped grip; then click the new fitting to connect the pipe
to the fitting. Press Esc to clear the selection of the pipe.

7. Delete the 90° fitting at circle E, and repeat steps 5 and 6 to replace it
with a 45° fitting.
8. On the ribbon, select 6 INCH (150mm) TEE as the current fitting.

9. Delete the 90° fitting at circle F2, and repeat steps 5 and 6 to replace
it with a 6 INCH (150mm) TEE.

10. In the plan view on the left, click the newly created tee; then click the
northern plus-sign grip. Snap to the center of circle H to create a new
pipe. Press Esc twice to end the command and clear the selection.
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11. Save and close the drawing.

You can view the results of successfully completing this exercise by opening
Editing a Pressure Network Using Plan Layout Tools - Complete.dwg
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Editing Pressure Networks Using the Profile
Layout Tools

As you may have noticed in Figure 15.8, there is also a Profile Layout Tools
command. The editing tools available for pressure networks in profile view are a
bit more numerous when compared to gravity networks. For example, with pres-
sure networks, you can add new pipes, add fittings, extend pipes, and perform
several other functions that aren’t possible with gravity pipes. When you click
the Profile Layout Tools command, the Pressure Network Profile Layout ribbon
tab opens (see Figure 15.9); it provides many useful editing commands that are
carried out in profile view.

d Pressure Pipe 4 INCH DUCTILE IRON - \ 3 5 X

Jordan Court . 3 6INCH ELBOW 45 DEG A Delete Part 7« Change Elevation
MNetwork Pil Curve Follow Close

P
Properties y ¥ EBends & Add Appurtenance gatevalve-finch-pushon-s ¥ Pipe Surface [P Panorama

Layout Modify

FIGURE 15.9 Thespecialized ribbon tab for pressure pipe layout in profile view

Exercise 15.6: Use the Profile Layout Tools

In this exercise, you'll use the Profile Layout Tools to design the portion of the
Jordan Court waterline that connects to the existing water main. You’ll add ver-
tical bends as well as a valve.

1. Open the drawing named Editing a Pressure Network Using
Profile Layout Tools.dwg located in the Chapter 15 class data
folder.

2. Click the new pipe that runs from circle H to circle F2 and the tee fit-
ting at Circle F2. Click Draw Parts In Profile on the ribbon, and click
one of the grid lines in the Jordan Court profile view.

The new pipe and fitting are drawn in the profile view. Notice the
tee connection and the short pipe stub located down from and to the
left of the new pipe. This is the location where the new waterline will
connect to the existing waterline.
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3.

10.

With one of the pipes or fittings selected, select Edit Network >
Profile Layout Tools on the ribbon.

Next to Add Bend, select 6 INCH (150mm) ELBOW 45 DEG. Then
click Add Bend.

In the upper-right viewport, place your cursor near the right end
of the short pipe segment located just below the red circle. When
the glyph appears, as shown in Figure 15.10, click the pipe. Click
Counterclockwise on the command line.

e

FIGURE 15.10 Aglyphindicating the proper connection of a pipe to a fitting

Verify that 6 INCH (150mm) DUCTILE IRON is selected as the cur-
rent pipe size, and click Add Pressure Pipe. When prompted for the
part at the start of the range, click the newly created elbow.

When prompted for the part at the end of the range, click the pipe
to the right of the red circle. Click Yes when asked if you want to
continue.

Click the newly created elbow, and then snap to the center of the red
circle located above the new bend.

Click Add Bend; then click the end of the newly created pipe, mak-
ing sure the proper glyph is displayed, as previously shown in
Figure 15.10. Click Clockwise on the command line to invoke the
Clockwise option. Another 45° bend is created.

Click the pipe just to the right of the newly created bend. Click the
upright triangle grip at the left end of the pipe, and drag it toward the
new bend. Click the newly created bend to connect the pipe to it.
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A new 45° bend should
appear. It may look odd
in profile view because
of the vertical exag-
geration. If you zoom
in to the new fitting in
the 3D view, it will look
more like you would
expect.

You could have also
done this step using
the 3D view or the
plan view.
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appear in the profile 15.

In the 3D view, you can now see the complete design of the
connection between the existing and proposed water mains (see
Figure 15.11).

FIGURE 15.11 Theconnection of the proposed waterline to the existing
waterline, shown in a 3D perspective

On the ribbon, click Break Pipe. Locate the two vertical red lines on
the first pipe segment, and click where the red line on the left crosses
the top of the pipe.

Repeat the previous step for the red line on the right.

On the ribbon, click Delete Part. Click the pipe segment between the
red lines.

Click Add Appurtenance, and then click the left side of the gap cre-
ated by deleting the pipe segment in the previous step.

Click the pipe on the right side of the gap to display its grips. Click
the upright triangle grip, and drag it toward the new valve. Click
when the glyph appears, indicating that a connection is going to be
made. View the tee and valve assembly in the lower-right viewport
(see Figure 15.12).
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FIGURE 15.12 The connection of the proposed waterline to the existing
waterline, shown in plan, profile, and 3D perspective

16. Press Esc to clear all the selections in the drawing. In profile view,
pan to the right and select the long pipe. Click Follow Surface on the
Pressure Network Profile Layout tab of the ribbon.

17. Press Enter; then type 4.5 (1.5) at the command line when prompted
for the depth below the surface. Press Enter to complete the
command.

18. Save and close the drawing.

You can view the results of successfully completing this exercise by opening
Editing a Pressure Network Using Profile Layout Tools - Complete.dwg.

Now that you have completed this chapter, you understand pressure networks and how they
differ from gravity networks. You're able to create pressure networks by converting objects
already in the drawing or by creating them from scratch using the layout tools. You know
several methods for editing pressure networks, including the use of grips, Plan Layout Tools,
and Profile Layout Tools.
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You're ready to begin creating and editing pressure networks in a production environment.
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The pipe has been
broken into segments
so that it can maintain
a constant depth below
the surface.
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